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appendix 
c

Using Adobe Bridge

As digital images start to pile up on your hard drive, the ability to sift through 
them quickly and efficiently becomes more and more important. Enter Adobe 
Bridge CS5, an image-browsing and organization powerhouse that’s been 

shipping with Photoshop for years. Browsing through your images in Bridge used to 
be a painfully slow process, and the program’s workspace wasn’t very intuitive. But 
in recent versions, Bridge got a speed boost, a makeover, and a Review mode that 
photographers really love (page 7 of this appendix). And it just keeps getter better: 
Bridge CS5 sports an Export panel (page 15 of this appendix) that lets you convert a 
slew of Raw files to JPEG and save them to a certain location. The “Output to PDF” 
option now lets you add watermarks to individual images (page 16 of this appendix), 
and you can now save your PDF and web gallery settings to use again later. Yippee! 

Note: In Photoshop CS5, you can also access Bridge inside Photoshop using the new Mini Bridge. Skip 
over to page 3 of this appendix for a sneak peek.

In the following pages, you’ll learn the basics of browsing, importing, and rating 
your images in Bridge. By the end of this appendix, you’ll be able to find your favor-
ite photos and plop them into a super-slick slideshow in no time.

Browsing Your Photos
If you’re working in Photoshop CS5, you can open Bridge by clicking the Launch 
Bridge button in the Application bar (page 14)—it looks like a square with the let-
ters Br inside it. If Photoshop isn’t running, you can double-click the Bridge icon in 
the Adobe Bridge application folder (on a PC, go to Start➝All Programs➝Adobe 
Bridge CS5). Either way, you see the window shown in Figure C-1.
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Figure C-1:  
You can use Bridge to 
browse all the images 
on your hard drive, 
not just the ones 
you’ve downloaded 
from your camera, 
using Bridge. The 
various panels shown 
here harbor different 
kinds of info, and 
they’re all resizable 
and movable. To 
move a panel, drag 
its tab; to resize a 
panel, drag the bar 
that divides it from 
other panels; and to 
combine panels, drag 
one panel’s tab into 
another panel.
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The Bridge window shows you a variety of info about your images in collapsible 
panels. You can use the Folders panel on the left to navigate to a specific spot on your 
hard drive to view the images stored there. When you click a folder in this panel, 
Bridge displays its contents as thumbnails in the Content panel (use the slider at the 
bottom of the Bridge window to control how big those thumbnails are). Click an im-
age in the Content panel to see a larger version of it in the Preview panel on the right.

Tip: To see a quick preview of an image, just select the file you want to view and then tap the space bar, 
and Bridge shows it to you full screen. Press the space bar again to go back to the Bridge window.

For quick access to certain folders, add them to Bridge’s Favorites panel. Select the folder in the Folders or 
Content panel and then choose File➝“Add to Favorites” (or simply drag a folder from the Content panel 
into the Favorites panel). From now on, you’ll have one-click access to that folder in the Favorites panel.
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At the top of the Bridge window are controls that help you find the files you want 
(shown in Figure C-1):

• Forward and back arrows. Click these buttons to move through the folders 
you’ve recently viewed. For example, if you went to your Friends folder and 
then opened the Blackmail folder inside it, click the back arrow to return to the 
Friends folder. (These buttons don’t select files, just folders.)

• Go to parent or Favorites. Like the back arrow button, this menu lets you move 
up a folder level. For example, if you’re perusing the Midnight Madness folder 
that lives inside your Photoshop World folder, you can use this menu to quickly 
pop into the Photoshop World folder (which is called the parent folder because 
it’s one level above the Midnight Madness folder in your computer’s file-orga-
nization family tree). You can also use this menu to access folders that you’ve 
added to the Favorites panel.

• Go to recent files/folders. This menu lists all the files and folders you’ve recent-
ly viewed, and it includes a list of files and folders categorized by the program 
that made them. When you choose an item from this menu, Bridge displays a 
preview of the item along with its location on your hard drive.

• Path bar. This outrageously useful bar is a clickable, virtual trail of breadcrumbs 
that helps you keep track of where you are. It shows you which folder you’re in; 
if you want to jump to a different spot in the trail, simply click the name of 
another folder in this bar. Since the Path bar shows you how you arrived at the 
folder you’re in, you always know exactly where you are (and the clickable links 
offer you a fast track backwards). If you don’t see it—or it’s mysteriously disap-
peared, as it sometimes does—choose Window➝Path Bar.

• Search bar. If you know the name of the file you’re looking for but don’t remem-
ber where it lives, type its name (or the first few letters of it) into this field and 
then press Return (Enter on a PC). Bridge scours your hard drive and shows you 
a list of the files that best match what you were searching for.

Tip: If you don’t have a big monitor but want to keep Bridge open—so you can drag and drop images 
from it into Photoshop, say—click the “Switch to Compact Mode” button in Bridge’s upper-right corner 
and the Bridge window shrinks down to a more manageable size. Click this button again to expand the 
window back to normal size. Better yet, pop open the new Mini Bridge in CS5, as described next.

Using Mini Bridge
In Photoshop CS5, you can open a smaller version of Bridge—cleverly named the 
Mini Bridge—within Photoshop by hopping up to the Application bar and clicking 
the little square labeled Mb (you can also open it by clicking its icon in the panel 
dock, shown in Figure C-2). Mini Bridge looks and works like big Bridge, but you get 
the added bonus of not having to switch program windows to get to it.



4 Photoshop CS5: The Missing Manual

Browsing Your 
Photos

Figure C-2:  
The Mini Bridge lives inside Photoshop and 
gives you even easier access to your images. 
You can drag and drop single or multiples 
files from the Mini Bridge panel right into your 
Photoshop window (or document), as shown 
here. As soon as you release your mouse but-
ton, Photoshop opens each image in its very 
own tabbed document. 

You can access the new Mini Bridge from 
within InDesign CS5, too!
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When you first open Mini Bridge, you’ll see its Home screen, which contains two 
buttons: Browse Files and Settings. Click Browse Files and Photoshop sends a mes-
sage to big Bridge to get its tail in gear if it’s not already running. If you click Settings, 
you get the following options:

• Bridge Launching lets you decide when big Bridge, well, launches. Your choices 
include automatically when you open Mini Bridge (a good idea for faster file 
access), or the factory setting of waiting until you click Browse Files.

• Appearance lets you tweak how Mini Bridge looks. You can change the panel’s 
brightness by dragging the slider to the left to brighten or to the right to dim. 
The Image Backdrop slider lets you lighten or darken the panel’s background; 
drag it all the way left for white, or all the way right for black (dark gray is easi-
est on the eyes). The Color Manage checkbox, which is turned on, uses your 
monitor’s color profile (page 48) to help Mini Bridge more accurately display 
image colors. 

To exit the Settings panel, click the tiny Browse Files icon at the top right of the panel 
(it looks like a little photo of a sailboat). You can access these options anytime by 
choosing Settings from the panel’s menu. 

Note: If you undock the Mini Bridge panel and then close it, there’s no way to reopen it. For reasons un-
known to mere mortals, it doesn’t exist within the Window menu. The fix is to click the Workspace menu 
in the Application Bar and choose Reset Essentials.
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Once you click Browse Files, you’ll see a list of folders near the top left and any im-
ages inside then as thumbnails underneath. Here’s a cheat sheet for what the various 
buttons labeled in Figure C-2 let you do:

• Use the Panel view menu to turn the Path bar, Navigation, and Preview panels 
(the last two are called pods in the Mini Bridge panel) on or off.

• The Select menu lets you refresh (update) the Mini Bridge’s contents, as well 
as show and hide rejected files (page 8 of this appendix), hidden files, or whole 
folders. You can also choose Select All, Deselect All, or Invert Selection (so what 
was selected isn’t, and what wasn’t selected is).  

• The Tools menu contains two options: Place and Photoshop. If you don’t have 
any Photoshop documents open, the Place command opens the currently se-
lected file (in Bridge, not Mini Bridge) as a new tabbed document. If you have 
a file open, it places the image inside the open file on its own layer (as a Smart 
Object if you’ve left that preference turned on—see page 125). The Photoshop 
menu gives you access to commands that run on multiple files or folders, such 
as Batch (great for renaming a slew of files at once, see page 11 of this appendix), 
“Load Files into Photoshop Layers” (page 59),  “Merge to HDR Pro” (page 414), 
and Photomerge (page 305). 

• The Sort menu lets you determine in what order the thumbnails are shown: by 
file name, type, date created, and so on (page 9 of this appendix).

• Use the Filter menu to make Mini Bridge show you files that have a certain star 
rating, label, and so on (page 10 of this appendix). 

• The View menu lets you choose how your thumbnails are displayed. Your 
choices include Show Items as Pages, Show Thumbnails Only, Grid Lock, As 
Filmstrip, As Details, or As List.

• The button labeled “Single image preview” opens a slightly bigger Preview 
pod, making it easier to actually see the image. (You can do the same thing by 
pressing Shift+space bar.) Once it’s opened, you have to close it in order to do 
anything else in Mini Bridge—click the Close button or the tiny x at the top left 
of the Preview pod to get it done.

• The Preview menu lets you tweak the Slideshow settings in big Bridge (see page 
15 of this appendix), enter Review mode (page 7 of this appendix), pop open 
a full screen preview (you can also just press the space bar), or open the bigger 
Preview pod discussed above. 

Tip: Mini Bridge works just like the other panels you learned about in Chapter 2; you can undock it from 
the right side of your screen and drag it anywhere you want. By docking it to the bottom of your Photo-
shop window, the previews are easier to see and you’ll free up precious screen real estate.  
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Bridge makes importing images a snap, and you can make it perform all kinds of 
wonderful housekeeping chores for you. For example, it can automatically rename 
your photos and add keywords, descriptions, and copyright info to each file. You can 
also have it back up your files as part of the import process, to an external hard drive 
you’ve plugged in or to another spot on your internal hard drive).

To import images, make sure your card reader is attached (see the box on page 9 
of this appendix) and then choose File➝“Get Photos from Camera” or click the 
tiny camera icon at the top of the Bridge window. Bridge opens the Adobe Photo 
Downloader in standard mode, which isn’t very impressive (if it’s the first time you’ve 
downloaded photos with Bridge, you’ll see the dialog box mentioned in the Tip be-
low); its most redeeming feature is the Advanced Dialog button at the bottom left. 
Click it to switch to advanced mode, shown in Figure C-3. At the top of this extreme-
ly useful dialog box, you can tell Bridge where to save your precious images by click-
ing the Choose button. The Downloader also lets you pick which images you want 
to import (turn on the appropriate checkboxes like the one circled in Figure C-3), 
give your images meaningful names, and instruct Bridge to back up your images by 
turning on the Save Copies To checkbox. Once you’ve got the options just right, click 
Get Photos and then sit back and relax. (For more tips on importing your images 
onto your computer, skip ahead to the box on page 9 of this appendix.)

Figure C-3:  
Importing images 
with Bridge is a huge 
timesaver. Plus, 
if you’ve got an 
external hard drive 
plugged in, you can 
turn on the “Save 
Copies to” checkbox 
(circled) and sleep 
better knowing you 
have extra cop-
ies of your photos 
stored somewhere 
other than your main 
computer. 
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Tip: The first time you choose File➝“Get Photos from Camera”, Bridge asks if you want it to automati-
cally open each time you attach a card reader to your computer (or plug in your camera’s USB cable). If 
you want to use Bridge to import all your photos, click Yes. This saves you a couple of clicks each time you 
import images because Bridge automatically launches and opens the Photo Downloader dialog box. 

If you’ve already hightailed it past this dialog box, you can access it in Bridge’s preferences. Choose 
Bridge➝Preferences➝General (Edit➝Preferences➝General on a PC) and turn on the “When a Camera 
is Connected, Launch Adobe Photo Downloader” setting. In Windows 7 and Vista, you may also need 
to open your Control Panel and set your AutoPlay preferences to use Bridge to download photos. In XP, 
you have to right-click on your hard drive in the Windows Explorer or My Computer window, choose 
Properties➝AutoPlay and then set it to launch Photodownloader.exe. Whew!

Using Review Mode
After you import images, you can use Bridge’s Review mode to see them in a giant, 
floating carousel (see Figure C-4). It’s a quick and easy way to view your images full-
screen, mark the ones you don’t like, and apply star ratings to the ones you do.

POWER USERS’ CLINIC

Customizing the Bridge Window
You can customize your Bridge workspace just like you can 
in Photoshop, or use one of its built-in layouts. Near the 
middle of the Bridge window is a list of workspaces that 
arrange the panels in a variety of ways—see Figure C-1. 
Here’s what each one does:

• Essentials is the workspace arrangement you see 
when you first open Bridge: The Favorites and Fold-
ers panels are on the left, the Content panel is in the 
middle, and the Preview panel is on the right. It’s a 
handy workspace for sifting through the files on your 
hard drive.

• Filmstrip is great for looking at photos you’ve im-
ported. The Favorites and Folders panels are still on 
the left, but the Content panel is down at the bottom 
of the window as a wide, thin strip, and the Preview 
panel takes center stage. Photographers like this 
workspace because it gives them a nice big preview.

• Metadata shows you all kinds of info about your im-
ages. There’s no big Preview panel in this workspace; 

the Content panel takes center stage and shows you 
a list that includes the date each file was created, its 
size, type, and so on. The Favorites panel appears on 
the left along with the Metadata panel, which shows 
you statistics about the file like its dimensions, resolu-
tion, and so on.

• Output sticks the Folders panel on the left, Content 
panel in the middle, and the Output panel on the 
right. The Output panel lets you create PDFs and Web 
galleries, as explained later in this chapter.

If these workspaces don’t float your boat, you can make 
your own. Once you’ve moved and resized the panels just 
the way you like, click the tiny down-pointing triangle to 
the right of the Output button and choose New Workspace. 
Give it a meaningful name and then click Save. Your cus-
tom workspace appears as a button at the top of the Bridge 
window. If you want to get rid of it, click the triangle again, 
choose Delete Workspace, select the offending workspace 
in the resulting dialog box, and then click Delete.
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Figure C-4:  
In Review mode, 
press �-1, 2, 3,4, or 
5 (Ctrl+1, 2, 3, 4, or 
5 on a PC) to give an 
image a rating of 1 to 
5 stars, or press the 
down arrow button in 
the lower-left part of 
the window to reject 
an image (mark it as 
one you don’t like). 
Once you’ve rejected 
images, you can 
filter them out and 
delete them in one 
fell swoop, as the 
next section explains. 
If you want to take a 
closer look at part of 
your image, click the 
Loupe button in the 
window’s bottom-
right corner or just 
click the image.

Left/Right Reject Loupe Create Collection Exit

Note: You can also mark images as rejected in the main Bridge window. Simply select the image’s thumb-
nail and then press Option-Delete (Alt+Backspace on a PC).

To use Review mode, select a folder in the Folders panel or choose multiple images 
in the Content panel by �-clicking (Ctrl-clicking on a PC) or Shift-clicking them. 
Then press �-B (Ctrl+B on a PC) or click the Refine button at the top of the Bridge 
window (it looks like a stack of paper) and choose Review Mode. Either way, Bridge 
takes over your screen and displays all your images on a gray background. By using 
the left and right arrow buttons at the bottom-left corner of your screen, you can flip 
through your images quickly. To exit Review mode and return to the Bridge window, 
click the X in the bottom-right corner of your screen or press Esc.

Tip: To rotate your images in Review mode, select an image, press and hold � (Ctrl on a PC) and then 
press the left or right bracket key. Pressing �-] rotates your image clockwise, and pressing �-[ rotates it 
counterclockwise.
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Tips for Importing Photos
Here are a few pointers for importing photos from your 
digital camera quickly and safely that will also help you find 
the little buggers on your hard drive later on:

• Always use a card reader. The slowest way to 
import photos is by using the USB cable that came 
with your camera. It’s sweet that the camera manu-
facturer included it, but those cables are super cheap. 
The USB cable’s low quality makes using it danger-
ous—the cheaper the cable, the greater the chance 
that something will go wrong. Fortunately, you can 
avoid this risk by getting a card reader, which imports 
photos much faster and more reliably. You simply 
take the memory card out of your camera, stick it in 
the card reader, and connect the reader to your com-
puter. Card readers are inexpensive (you can get a 
SanDisk ImageMate 12-in-1 for under $15) and most 
models can read several different kinds of memory 
cards (that’s what the “12-in-1” part means), which 
is a nice bonus if you have more than one brand of 
camera. Also, take care that you don’t yank a mem-
ory card out of the card reader until you’ve properly 
ejected or dismounted it from your computer by 
choosing File➝Eject.

• Erase memory cards only in your camera. Most 
photo importing/organizing software offers to erase 
photos from your memory card after it imports them 
onto your computer. Resist the urge to say yes, and 
instead stick the memory card back into your camera, 

and then use the camera’s menus to reformat the 
card to erase your images. This protects you from 
losing files if there’s some kind of crash or stall while 
they’re importing, which can corrupt your photos 
(and, if the software has already erased them from 
the memory card, you can’t re-import them). Also, 
many folks believe that reformatting memory cards 
rather than erasing them helps reduce the risk of 
cards getting corrupted and losing your photos. To 
learn how to reformat your memory card, dig out the 
manual that came with your camera.

• Give photos meaningful names. Instead of stick-
ing with the completely useless names your camera 
assigns to each photo, give them meaningful names 
when you import them. Programs like Bridge can au-
tomatically number the files for you and tack on a 
name like Photoshop World. You’ve got to admit that 
the name Photoshop World 08_1.jpg is a lot more 
descriptive than DCS_00102.jpg.

• Use several small memory cards instead of one 
big one. No matter how well you care for them, 
memory cards—like any storage device—can fail and 
lose all the precious images stored on ’em. For that 
reason, consider carrying four 2 GB cards instead of a 
single 8 GB card; that way, you’ll lose fewer photos if 
one of the cards goes south.

Sorting and Filtering Images
Bridge gives you a lot of flexibility when it comes to viewing your image collection. 
For example, you can use the Sort menu at the top of the Bridge window (see Figure 
C-5) to arrange your images by name, date modified, size, and so on. You can also 
sort them manually, which lets you use the Content panel to drag them into any 
order you want. Sorting is also a quick way to toss the images you’ve rejected (page 8 
of this appendix). To do that, choose Show Rejected Items Only from the Sort Menu, 
and then choose File➝Move To Trash.
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Figure C-5:  
Top: The Filter panel (Window➝Filter Panel) 
can help you limit the images Bridge displays. 
For example, if you’ve rated your images, you 
can filter your image collection by clicking the 
panel’s stars (circled). In this example, Bridge is 
displaying just the 3- and 4-star images. To filter 
your images using other criteria like the date 
they were created or their orientation, Ctrl-click 
(right-click on a PC) the Filter panel and then 
choose an item from the resulting menu.

Bottom: You can also use the star menu at the 
top of the Bridge window to filter your images. 
The Sort menu to its right lets you control the 
order in which Bridge displays the thumbnails. 
If Bridge is taking a long time to display images 
as you scroll or after you filter them or perform 
a search, you can use the icons shown here 
to lower the thumbnails’ quality, which makes 
Bridge draw them a little faster.

If you’ve filtered your images but now want to 
see them all, press Opt-�-A (Alt+Ctrl+A on a PC) 
to remove the filter.

Change thumbnail quality
Filter by star rating

Open
recent

New
folderSort Rotate

The Filter panel lets you weed out images by displaying only those that match certain 
criteria, like a specific star rating (see Figure C-5). (If you don’t see the Filter panel, 
choose Window➝Filter Panel.) If you didn’t use Review mode to rate your images 
after you imported them (page 7 of this appendix), you might want to rate them 
now so you can quickly view your best images. Rating and sorting is handy if you’re 
a stock photographer: You can give future submissions a 5-star rating and then find 
them quickly using the 5-star filter.
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Renaming Multiple Files
If you forgot to rename your photos when you imported 
them or if you’d like to rename other files on your hard 
drive, you don’t have to change their names one at a time—
that’d take days. Instead, you can have Bridge rename en-
tire folders of images for you using a simple process called 
batch renaming. 

From the Refine menu at the top of the Bridge window 
(it looks like a stack of paper), choose Batch Rename or 
just press Shift-�-R (Shift+Ctrl+R on a PC). The Destina-
tion Folder section of the resulting dialog box—which was 
updated in CS5 to make it easier to use—lets you choose 
to rename your images without moving them, or move or 
copy them to a different folder. The New Filenames section 
includes several options for customizing your files’ names. 
Click one of the fields on the left side of this section to see 
the following options in a drop-down menu:

• Text. Choose this option to add your own text to the 
beginning of the file names. For example, if you shot 
a series of photos at Photoshop World, you could add 
“PhotoshopWorld” to the beginning of each name.

• New Extension adds whatever you enter in this field 
to the end of your images’ names, replacing the origi-
nal extension. Beware, though: Changing or adding a 
new extension to your file name doesn’t change the 
file’s format, so your computer may not know what 
kind of file you really have if, for example, you add a 
.TIF extension to the end of a .JPG file.

• Current Filename leaves the file name that’s already 
assigned to each image in place and adds your other 
custom name changes to it.

• Preserved Filename tells Bridge to keep the original 
metadata file name—the one assigned by your cam-
era—as part of the new file name.

• Sequence Number adds a unique number to each 

image. You pick the starting number and Bridge 
counts up by one for each file it renames.

• Sequence Letter works just like Sequence Number, 
but it adds a unique letter to each file name instead.

• Date Time adds a date and time stamp to each file’s 
name.

• Metadata lets you include metadata (page 58) in 
each file’s name. You can choose from several pieces 
of info that your camera embedded in your image 
files.

• Folder Name includes the name of the folder your 
images are in as part of the new file name.

• String Substitution (new in CS5) lets you find an 
element in the old file name (a piece of text, for ex-
ample) and replace it with something else.

You can add and remove items from the New Filenames 
section by clicking the + or – button to the right of each 
option. Be sure to remove items you don’t plan on using so 
Bridge doesn’t include info you don’t want. 

In the Options section, turn on the “Preserve current file-
name in XMP Metadata” checkbox to leave the current file 
name that’s stored in the file’s metadata alone (in case you 
ever need to go back to it). And if there’s a chance your 
renamed images will end up on different computer plat-
forms, be sure to turn the Compatibility checkboxes for the 
appropriate operating systems. For example, if you use a 
Mac but your client uses PCs and Unix computers, turn on 
the Windows and Unix checkboxes.

At the bottom of the Batch Rename dialog box, you see an 
example of what your files are named and what they will 
be named. If everything looks good, take a deep breath, 
click Rename, and Bridge makes the changes in the blink 
of an eye.
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If you applied keywords when you imported your files, you can use those keywords 
to filter your images. Just open the Filter panel and you’ll see a list of keywords ap-
plied to the files in the folder you’re viewing. Click a keyword (it’ll turn bold) and the 
Content panel displays only images with that particular keyword.

Grouping Images into Collections
Another way to organize your images is to put them into folders called collections. 
Bridge lets you create two types of collections:

• User-defined collections are ones you make by dragging and dropping images 
into a special folder. To create this kind of collection, click the Collections panel 
at the bottom-left part of the Bridge window or choose Window➝Collections 
Panel. Select the images you want to include, click the New Collection button 
(shown in Figure C-6, top), give your collection a name, and then press Return 
(Enter on a PC). If you want to add more images, just use the Folders or Favor-
ites panel to find the images you want to include and then drag them into the 
brown folder Bridge created.

Tip: You can create a user-defined collection while you’re in Review mode by clicking the Create Collec-
tion button shown in Figure C-4.

• Bridge creates Smart Collections according to criteria you set in the dialog box 
shown in Figure C-6 (bottom right). Just click the New Smart Collection button 
at the bottom of the Collections panel and enter your criteria in the resulting 
dialog box. Click save when you’re finished and Bridge finds the images that 
match your requirements. If you’ve told Bridge to look through your whole hard 
drive, this may take a while!

Opening Images in Camera Raw
One of the many benefits of organizing and browsing your images in Bridge is that it 
works with the Camera Raw plug-in (page 58). Bridge gives you lots of ways to open 
your images in Camera Raw:

• Double-click a Raw file and Camera Raw pops right open.

• Select an image in the Content panel and then press �-R (Ctrl+R on a PC). This 
method lets you open Raw files, JPEGs, and TIFFs in Camera Raw.

• Select an image and then choose File➝“Open in Camera Raw”.

• Ctrl-click (right-click) the image and then choose “Open in Camera Raw” from 
the shortcut menu that appears.

• Select an image and then click the iris icon at the top of the window.
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Figure C-6:  
Top: Once you create 
a user-defined col-
lection, you can drag 
several photos into 
it at once, as shown 
here. (You can tell 
this is a user-defined 
collection because its 
folder is brown.)

Bottom: With a Smart 
Collection, you use 
the Smart Collection 
dialog box (left) to 
tell Bridge which 
photos to fetch. Use 
the “Look in” pop-up 
menu to tell Bridge 
where to look for the 
images and then set 
criteria using the pop-
up menus below it. 
To add more criteria, 
click the + button. 
Once you’ve made 
the Smart Collection, 
you can go back and 
tweak your criteria 
by clicking the Edit 
Smart Collection 
button (right). Smart 
Collections have blue 
folders, as shown 
here.

Edit Smart
Collection

Delete
Collection

New Collection Smart Collection

Once you’ve edited an image in Camera Raw, a couple of microscopic icons appear 
next to the image’s preview in Bridge’s Content panel (see Figure C-7). If you’ve got 
several images that need the same edits, you can copy the changes from one image 
and apply them to others right here in Bridge. Just Ctrl-click (right-click on a PC) 
the image in the Content panel and then choose Develop Settings➝Copy Settings 
from the resulting shortcut menu. Then select the images you want to apply the 
edits to, Ctrl-click (right-click) them, choose Develop Settings➝Paste Settings, and 
Bridge applies those same edits to those images. Now that’s working smarter, not 
harder!
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Figure C-7:  
When you edit an image in Camera Raw 
and then click Done in the Camera Raw 
window, tiny icons representing the kinds 
of edits you made appear next to the 
image in Bridge. The icons circled here 
indicate that the image was cropped and 
its exposure was changed. Ctrl-clicking 
(right-clicking) an image in Bridge’s Con-
tent panel brings up this shortcut menu, 
which includes all kinds of timesavers.

Showing Off Your Work
Bridge gives you several ways to display your work, including a nifty slideshow gen-
erator and an Output panel that lets you create PDFs and Web galleries. In Bridge 
CS5, you can even use the new Export panel to automate the process of creating 
JPEG versions of your masterpieces. Read on!

Making a Slideshow
If you need to show your work to a client or family member, you can quickly filter 
your top-rated images (see Figure C-5) and have Bridge play them as a full-screen 
slideshow. Here’s how:

• To start an instant slideshow, select a folder or several images by Shift- or 
�-clicking (Ctrl-clicking on a PC) them, and then choose View➝Slideshow. 
That’s it! Your photos immediately appear onscreen, one after the other (each 
one stays onscreen for 5 seconds). To exit the slideshow, press Esc. You can also 
start a slideshow by pressing �-L (Ctrl+L on a PC).
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• To customize the slideshow’s settings first, choose View➝Slideshow Options 
or press Shift-�-L (Shift+Ctrl+L). In the resulting dialog box, you can make 
your slideshow repeat, control how many seconds each image stays onscreen, 
resize the slideshow window to fit your monitor, and add transitions between 
slides (see Figure C-8). The only thing you can’t do is add music (though you 
can always open iTunes and play music in the background).

Figure C-8:  
By adding a transition and turning on the “Zoom 
Back and Forth” checkbox (which makes Bridge 
zoom in and back out of each image) you can 
make a pretty slick slideshow in no time flat.

To create a slideshow you can export, use the 
PDF option explained in the next section.

Using the Export Panel
If you need to convert a slew of images to JPEGs, you can use Bridge CS5’s new Ex-
port panel. It takes a few steps: first you create a location (preset) for the exported 
files, next you add files to the location queue, and then export them. The good news 
is that once you get your locations set up, the export process goes quite quickly.

Note: Unfortunately, the Export Panel doesn’t work in the initial Bridge CS5 release, but Adobe expects to 
correct the problem within a few weeks of the ship date. Keep your fingers crossed!

Open the Export panel by choosing its tab at the bottom left of the Bridge window 
(if you don’t see it, choose Window➝Export Panel). Click the + sign at the bottom of 
the panel to add a new location preset. In the resulting dialog box’s Destination tab 
(Figure C-9, top), pick the folder where you want the exported images to land. Then 
click the Image Options tab and let Bridge know if you’d like it to make your images 



16 Photoshop CS5: The Missing Manual

Showing Off Your 
Work

smaller and/or reduce their quality (both great for posting on the Web; not so much 
if you plan to send the JPEGs to a stock image site). At the bottom of the dialog box, 
enter a meaningful name for your preset, click Save, and Bridge adds a new hard-
drive icon with that name to the Export panel, as shown in Figure C-9 (bottom).

Figure C-9:  
Top: If you’re a stock photog-
rapher, you can use the Export 
panel to create the highest qual-
ity JPEGs from your Raw files 
so you can submit them to your 
favorite stock image service. 

Bottom: Once you’ve set up a 
location, you can drag images 
onto the preset and Bridge adds 
them to its “to export” list. You 
can delete items from the list by 
hovering your cursor over the 
image and clicking the tiny x to 
its right. When you get the list 
just right, click the right-angled 
arrow to the right of the preset 
to send the images on their 
merry way. 

Remove

Click to export

Edit
Add

Delete Show in Bridge

Exporting Images as PDFs
PDFs are really handy because you can open them on any kind of computer without 
having to buy any software. Bridge has a few templates you can use to create PDFs, 
and a slew of settings you can use to customize exactly how your PDFs look (new 
in CS5 is the option to add watermarks to individual images in your PDF, instead 
one watermark per PDF page). Just select the image(s) you want to export and then 
click the word Output at the top of the Bridge window (or the Output icon shown in 
Figure C-10). Bridge opens the Output panel on the right side of the Bridge window.

At the top of the Output panel, make sure the PDF button is selected, and then 
choose a template from the Template pop-up menu. To see a preview of the template 
you picked, click the Output Preview tab in the center of the Bridge window (circled 
in Figure C-10). You don’t have very many templates to choose from, but you can 
customize them using the Output panel’s various settings (you’ll need to use the 
scroll bar on the panel’s right side to see all the settings—there’s a ton of ’em). If you 
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want your PDF to run as a slideshow, be sure the Playback options are turned on 
(they’re near the bottom of the panel). When everything looks good, click the Save 
button at the bottom of the Output panel and Bridge exports your file as a PDF.

Figure C-10:  
The Template menu 
doesn’t give you many 
options, but in CS5 
you can add your own. 
Contact Sheets are back, 
too, and you can tweak 
the various settings to 
create a contact sheet 
of your very own, as 
shown here. Keep in 
mind, though, that as 
you make changes in 
the Output panel, you 
have to click the Refresh 
Preview button (circled) 
to make Bridge update 
what’s shown in the 
Output Preview tab. 

Happily, you can save 
your custom settings in 
Photoshop CS5, unlike 
CS4, which is a welcome 
improvement after 
you’ve worked hard to 
create a PDF template 
or web gallery style that 
meets your needs.

Click to save settings as template

Note: Page 109 covers exporting layer comp files as PDFs.

Creating a Picture Package
Sadly, your days of using Photoshop to print multiple photos at popular sizes all on 
one sheet of paper are over—unless you download and install the optional plug-ins 
for Windows and Mac OS (page 707), or create an action of your very own that does 
it for you (Chapter 16 is all about actions).

Making a Web Gallery
You can also use Bridge to make a quick online gallery of your images. Heck, it’ll 
even upload the images for you! Flip back to page 743 for the scoop.


